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BAB 2  

LANDASAN TEORI 

2.1 Proyek Konstruksi 

Definisi proyek konstruksi merupakan suatu rangkaian kegiatan yang hanya 

satu kali dilaksanakan dan umumnya berjangka waktu pendek. Dalam rangkaian 

kegiatan tersebut terdapat, suatu proses yang mengolah sumber daya proyek 

menjadi suatu hasil kegiatan yang berupa bangunan. Proses yang terjadi dalam 

rangkaian tersebut tentunya melibatkan pihak-pihak yang terkait, baik secara 

langsung maupun tidak langsung. Hubungan antar pihak yang terkait dalam suatu 

proyek dibedakan atas hubungan fungsional dan hubungan kerja (Ervianto, 2009). 

2.2 Manajemen Proyek  

2.2.1 Definisi Manajemen Proyek 

Manajemen proyek adalah semua perencanaan, pelaksanaan, pengendalian 

dan koordinasi suatu proyek dari awal (gagasan) hingga berakhirnya proyek untuk 

menjamin pelaksanaan proyek secara tepat waktu, tepat biaya dan tepat mutu. Pada 

umumnya adanya manajemen proyek merupakan untuk mengatur jalannya suatu 

proyek pembangunan dimana mengawal gagasan hingga sampai ke sasaran yang 

telah direncanakan sehingga terpenuhi ketepatan waktu, mutu, dan biaya, serta 

upaya mengefisiensikan sumber daya yang ada (Ervianto, 2009). 

Manajemen proyek merupakan sebagai ilmu dan seni berkaitan dengan 

memimpin dan mengkoordinir sumber daya yang terdiri dari manusia dan material 

dengan menggunakan teknik pengelolaan modern untuk mencapai sasaran yang 

telah ditentukan yaitu lingkup, mutu, jadwal dan biaya, serta memenuhi keinginan 

para stakeholder (Soeharto, 1999). 

2.2.2 Tujuan Manajemen Proyek 

Tujuan manajemen proyek adalah pengelolaan fungsi manajemen sumber 

daya yang tersedia dengan dikelola sedemikian rupa sehingga diperoleh hasil yang 

optimum, serta penggunaan sumber daya yang efektif dan efisien. 

Menurut (Heryanto, 2013 dalam mahapatni, 2019) tujuan dan manfaat yang 

bisa didapatkan dengan adanya manajemen proyek antara lain: 

1. Efisiensi, baik dari sisi biaya, sumber daya maupun waktu.  
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2. Kontrol terhadap proyek.  

3. Meningkatkan kualitas.  

4. Meningkatkan produktifitas.  

5. Bisa menekan risiko yang timbul sekecil mungkin.  

6. Koordinasi internal yang lebih baik.  

7. Meningkatkan rasa tanggung jawab serta loyalitas tim terhadap proyek.  

2.2.3 Fungsi Manajemen Proyek 

Fungsi manajemen proyek merupakan mencakup urutan prosedur yang 

harus dijalankan dalam upaya mengelola suatu proyek konstruksi, jika semua fungsi 

telah berjalan, maka proyek akan mencapai keberhasilan.  

Menurut (Ervianto, 2002) fungsi dari manajemen konstruksi itu meliputi 

fungsi-fungsi dasar manajemen, yaitu diantaranya adalah sebagai berikut: 

a. Penetapan Tujuan (Goal Setting) 

Penetapan tujuan secara realistis, dimana memungkinkan untuk dicapai 

dengan sumber daya yang tersedia, serta dibuat secara spesifik, terukur dan 

memiliki kejelasan mengenai langkah yang akan ditempuh untuk mencapainya.  

Pembangunan Gedung Rektorat bertujuan untuk melengkapi sarana 

prasarana dan fasilitas gedung pada Kampus II Universitas Siliwangi di Mugarsari. 

Metode pelaksanaan yang digunakan memiliki ketelitian tinggi dengan 

mengoptimalisasi penjadwalan, memaksimalkan pengendalian serta pengontrolan 

sehingga hasil yang didapat akan lebih efisien dan sesuai perencanaan. 

b. Perencanaan (Planning) 

Perencanaan merupakan kegiatan merumuskan langkah yang akan 

dilaksanakan untuk mencapai tujuan yang telah ditetapkan. Pada kegiatan ini 

dilakukan antisipasi tugas dan kondisi yang ada dengan menetapkan sasaran dan 

tujuan yang harus dicapai serta menentukan kebijakan pelaksanaan, program yang 

akan dilakukan, jadwal waktu pelaksanaan, prosedur pelaksanaan secara 

administratif dan operasional serta alokasi anggaran biaya dan sumber daya (Husen, 

2010). 

Bentuk dari perencanaan dapat berupa bentuk: perencanaan prosedur, 

perencanaan metode kerja, perencanaan standar pengukuran hasil, perencanaan 

anggaran biaya dan perencanaan metode (Ervianto, 2002).  
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c. Pengorganisasian (Organizing) 

Pada kegiatan ini dilakukan identifikasi dan pengelompokan jenis-jenis 

pekerjaan, menentukan pendelegasian wewenang dan tanggung jawab personel 

serta meletakkan dasar bagi hubungan masing-masing unsur organisasi. Untuk 

menggerakkan organisasi, pimpinan harus mampu mengarahkan organisasi dan 

menjalin komunikasi antar pribadi dalam hierarki organisasi. Semua itu 

dibangkitkan melalui tanggung jawab dan partisipasi semua pihak. Struktur 

organisasi yang sesuai dengan kebutuhan proyek dan kerangka penjabaran tugas 

personel penanggung jawab yang jelas, serta kemampuan personel yang sesuai 

keahliannya, akan diperoleh hasil positif bagi organisasi (Husen, 2010). 

Tujuan dari kegiatan pengorganisasian yaitu untuk mengatur dan 

mengelompokan kegiatan proyek konstruksi agar kinerja yang dihasilkan sesuai 

harapan (Ervianto, 2002). 

d. Pengisian Staff (Staffing) 

Pada tahap ini merupakan tahap awal dalam perencanaan personel yang 

akan ditunjuk sebagai pengelola pelaksaaan proyek (Ervianto, 2002). 

Fungsi manajemen proyek ini harus dijalankan dengan ketelitian dan 

keberhasilan dalam menempatkan tenaga kerja sesuai dengan bidang keahliannya, 

hal tersebut akan menjadikan tenaga kerja tidak akan kesulitan dalam melaksanakan 

tugasnya, sehingga membawa dampak baik terhadap keberhasilan proyek. 

e. Pengarahan (Directing) 

Tahap pengarahan dapat didefinisikan sebagai kegiatan mobilisasi sumber-

sumber daya yang dimiliki agar dapat bergerak sebagai kesatuan sesuai rencana 

yang telah dibuat, termasuk didalamnya adalah memberikan motivasi dan 

melaksanakan koordinasi terhadap seluruh staff (Ervianto, 2002). 

Pada umumnya, pengarahan dimaksudkan untuk memperjelas tugas pokok 

dan fungsi dari setiap tenaga kerja, dimana tenaga kerja tersebut akan melaksanakan 

pekerjaan sesuai bidang yang telah ditentukan sebelumnya. 

f. Pengawasan (Supervising) 

Pengawasan dapat didefinisikan sebagai interaksi langsung antara individu-

individu dalam organisasi untuk mencapai kinerja dalam tujuan organisasi. Proses 
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ini dilaksanakan selama proyek berlangsung, guna mendapatkan keyakinan bahwa 

pelaksanaan kegiatan berjalan sesuai ketentuan (Ervianto, 2002). 

Kegiatan ini dapat disebut kegiatan monitoring, dimana dalam upaya untuk 

tetap menjalankan ketentuan yang berlaku dalam suatu proyek, sehingga 

mendapatkan hasil akhir yang sesuai tujuan (goal setting). 

g. Pengendalian (Controlling) 

Pengendalian adalah proses penetapan apa yang telah dicapai, evaluasi 

kinerja, dan langkah perbaikan apabila diperlukan. Esensi pengendalian adalah 

membandingkan rencana dengan aktual. Untuk membandingkan, maka perlu 

dilakukan pemantuan. Pemantauan kegiatan yang telah terjadi di lapangan harus 

dilakukan dari waktu ke waktu hingga proyek selesai (Ervianto, 2002). 

Menurut (Husen, 2010) bentuk pengendalian yang harus dilakukan adalah 

sebagai berikut: 

1. Supervisi dimana melakukan serangkaian tindakan koordinasi pengawasan 

dalam batas wewenang dan tanggung jawab menurut prosedur organisasi 

yang telah ditetapkan, agar dalam operasional dapat dilakukan secara 

bersama sama oleh semua personel dengan kendai pengawas. 

2. Inspeksi dimana melakukan pemeriksaan terhadap hasil pekerjaan dengan 

tujuan menjamin spesifikasi mutu dan produk sesuai dengan yang 

direncanakan. 

3. Tindakan koreksi dimana melakukan perubahan dan perbaikan terhadap 

rencana yang telah ditetapkan untuk menyesuaikan dengan kondisi 

pelaksanaan. 

h. Koordinasi (Coordination) 

Koordinasi memiliki tujuan untuk mengefektifkan serta mengefisienkan 

proses integrasi tujuan dari kegiatan antara departemen atau bidang yang memiliki 

satu tujuan yang sama untuk dicapai. 

Pada dasarnya koordinasi merupakan upaya melaksanakan kegiatan-

kegiatan yang telah dirumuskan yang mempunyai tujuan bersama yang menjadi 

sasaran kegiatan tersebut.  
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Dari setiap fungsi manajemen tersebut merupakan tahap yang harus 

dijalankan secara efektif, maka pengelolaan proyek akan berhasil baik yang 

menghasilkan ketepatan dari semua aspek mutu, waktu dan biaya.   

2.3 Konsep Value for Money 

Di dalam upaya proses pencapaian tujuan, terdapat batasan yang harus 

dipenuhi yaitu besar biaya (anggaran) yang dialokasikan, jadwal (schedule), serta 

mutu yang harus dipenuhi (Soeharto, 1999). Adapun ketiga batasan disebut tiga 

kendala (triple constrain), dapat dilihat pada Gambar 2.1 berikut ini. 

 

Gambar 2.1 Sasaran Proyek, Tiga Kendala (Triple Constrain) 

Sumber: (Soeharto, 1999) 

Tiga aspek berikut dimana yang menjadi penunjang terlaksananya suatu 

proyek, dalam penetapannya juga diperlukan manajemen yang baik dalam upaya 

mencapai sasaran yang telah ditetapkan. Menurut (Soeharto, 1999) uraian dari tiga 

kendala (triple constrain) didefinisikan sebagai berikut: 

1. Anggaran merupakan dimana proyek harus diselesaikan dengan biaya yang 

tidak melebihi anggaran. Untuk proyek yang melibatkan dana dalam jumlah 

besar, anggaran ditentukan berdasarkan komponen-komponennya atau per-

periode tertentu yang jumlahnya disesuaikan dengan keperluan. 

2. Jadwal merupakan dimana proyek harus dikerjakan sesuai dengan kurun 

waktu dan tanggal akhir yang telah ditentukan. Apabila hasil akhir adalah 

produk baru, maka penyerahannya tidak boleh melewati batas waktu yang 

ditentukan. 

3. Mutu merupakan dimana produk atau hasil kegiatan proyek harus 

memenuhi spesifikasi dan kriteria yang dipersyaratkan, memenuhi 
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persyaratan mutu berarti mampu memenuhi tugas yang dimaksudkan atau 

sering disebut fit for the intenden use. 

Ketiga batasan tersebut bersifat tarik-menarik. Artinya, jika ingin 

meningkatkan kinerja produk yang telah disepakati dalam kontrak, maka umumnya 

harus diikuti dengan peningkatan mutu. Hal ini selanjutnya berakibat pada naiknya 

biaya sehingga melebihi anggaran. Sebaliknya, apabila ingin menekan biaya, maka 

biasanya harus berkompromi dengan mutu atau jadwal (Soeharto, 1999). 

2.4 Konsep Waktu dan Biaya  

Pada umumnya konsep waktu dan biaya merupakan termasuk upaya 

perencanaan dalam mengerjakan suatu proyek. Dengan merencanakan kemana 

biaya harus di alokasikan, untuk apa biaya digunakan serta berapa lama waktu yang 

dibutuhkan. Konsep tersebut juga harus disertai dengan pengontrolan, dengan 

tujuan kemana alur dari penggunaan biaya harus jelas semata-mata untuk mencapai 

tujuan. Apabila pekerjaan tidak terkendali yang menimbulkan keterlambatan 

waktu, maka biaya yang dibutuhkan untuk menyelesaikan proyek akan 

membengkak atau tinggi.  

2.4.1 Pengendalian Waktu 

Pengendalian waktu ditujukan agar waktu pelaksanaan konstruksi dapat 

berlangsung seperti yang direncanakan. karena sangat menentukan keberhasilan 

dari suatu proyek. Pada umumnya perubahan waktu pelaksanaan akan 

mempengaruhi anggaran apabila konstruksi proyek masih berlangsung, jelas bahwa 

penyelesaian aktual harus dibandingkan dengan rencana menyeluruh (Didik, 2013 

dalam Faridah, 2013). 

2.4.2 Pengendalian Biaya   

Pengendalian biaya diperlukan untuk menjaga kesesuain antara 

perencanaan dan pelaksanaan agar tidak melampaui rencana anggaran 

pelaksanaannya. Hal yang diperlukan untuk mengontrol pengendalian biaya adalah 

rencana anggaran pelaksanaan yang menyangkut mutu, volume, dan harga satuan 

pekerjaan yang didapatkan (Pratiwi, 2012). 

Biaya pada proyek dibedakan menjadi dua jenis, yaitu: 

1. Biaya langsung (direct cost) adalah seluruh biaya yang berkaitan dengan 

pekerjaan dilapangan. Besar biaya langsung 85% dari total biaya konstruksi 
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yang terdiri dari biaya peralatan sebesar 20-25%, material curah 20-25%, 

biaya konstruksi dilapangan yaitu tenaga kerja, material dan jasa 

subkontraktor 45-50% (Ritz, 1994 dalam Rahman, 2010). 

2. Biaya tidak langsung (indirect cost) adalah seluruh biaya yang tidak 

langsung berhubungan dengan konstruksi di lapangan. Besar biaya langsung 

berkisar 8-12% dari total biaya konstruksi, sedangkan biaya overhead 

kantor adalah 3-5% dari total biaya proyek (Ritz, 1994 dalam Rahman, 

2010). 

Adapun prosedur dalam pengendalian biaya, langkah-langkah yang 

digunakan adalah sebagai berikut: 

1. Merumuskan serta menetapkan target yang jelas, ini dilakukan pada tahap 

awal, sehingga dapat mengetahui langkah pekerjaan yang harus diselesaikan 

dengan kontrol tertentu. 

2. Lakukan evaluasi pekerjaan, bandingkan antara prestasi aktual dengan 

target. 

3. Berikan penilaian kinerja dari hasil evaluasi, apabila target terbilang masih 

kurang, maka lakukan kebijakan-kebijakan dengan tujuan mencapai sasaran 

dalam menyelesaikan pekerjaan selanjutnya. 

4. Membuat laporan akhir hasil pekerjaan untuk mengetahui sejauh mana hasil 

yang dicapai. 

2.5 Penjadwalan  

Penjadwalan proyek merupakan salah satu elemen hasil perencanaan, yang 

dapat memberikan informasi tentang jadwal rencana dan kemajuan proyek dalam 

hal kinerja sumber daya berupa biaya, tenaga kerja, peralatan dan material serta 

rencana durasi proyek dan progres waktu untuk menyelesaikan proyek. Dalam 

proses penjadwalan, penyusunan kegiatan dan hubungan antar kegiatan dibuat lebih 

terperinci. Penjadwalan atau scheduling adalah pengalokasian waktu yang tersedia 

untuk melaksanakan masing-masing pekerjaan dalam rangka menyelesaikan suatu 

proyek hingga tercapai hasil optimal dengan mempertimbangkan keterbatasan yang 

ada (Husen, 2010). 
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2.5.1 Kurva S 

Kurva S dapat menunjukan kemajuan proyek berdasarkan kegiatan, waktu 

dan bobot pekerjaan yang direpresentasikan sebagai persentase komulatif dari 

seluruh kegiatan proyek. Visualisasi kurva S dapat memberikan informasi 

mengenai kemajuan proyek dengan membandingkannya terhadap jadwal rencana, 

sehingga dari sinilah diketahui apakah ada keterlambatan atau percepatan jadwal 

proyek, maka indikasi tersebut dapat menjadi informasi awal guna melakukan 

tindakan koreksi dalam pengendalian jadwal (Husen, 2010).  

Untuk membuat kurva S, jumlah persentase komulatif bobot masing-masing 

kegiatan pada suatu periode di antara durasi proyek diplot terdahap sumbu vertikal 

sehingga apabila hasilnya dihubungkan dengan garis, akan membentuk kurva S. 

Untuk menentukan bobot pekerjaan, pendekatan yang dilakukan dapat berupa 

perhitungan persentase berdasarkan biaya per-item pekerjaan dibagi dengan nilai 

total anggaran, karena satuan biaya dapat dijadikan bentuk persentase sehingga 

lebih mudah untuk menghitungnya (Husen, 2010).  

2.5.2 Diagram Jaringan Kerja (Network Planning Diagram) 

Pada dasarnya diagram jaringan kerja merupakan perencanaan urutan 

pekerjaan yang divisualisasikan dengan garis panah sehingga dapat terlihat 

rangkaian keterkaitan pekerjaan mulai dan selesai serta pekerjaan selanjutnya. Pada 

diagram jaringan kerja juga dapat terlihat apabila sebuah kegiatan terlambat maka 

akan segera diketahui kegiatan apa saja yang dipengaruhi oleh keterlambatan 

tersebut serta dapat mengetahui pengaruh terhadap kemajuan proyek. 

2.5.3 Work Breakdown Structure (WBS) 

Pada umumnya proses penjadawalan dimulai dengan mengidentifikasi 

aktivitas proyek. Tujuan mengidentifikasi aktivitas yaitu agar aktivitas yang 

dilakukan untuk menyelesaikan pekerjaan yang bersangkutan dapat di kontrol 

dengan mudah serta dapat dimengerti pelaksanaannya, sehingga tujuan proyek yang 

telah ditentukan dapat terlaksana sesuai dengan jadwal.  

Dalam penentuan jumlah detail level WBS, disusun berdasarkan kebutuhan 

penggunaan schedule, tipe aktivitas (biaya, keamanan, mutu), ukuran serta 

kompleksitas, pengalaman, persediaan informasi yang di dapat, dan karakteristik 

sumber daya.  
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2.6 Konsep Nilai Hasil (Earned Value) 

Metode Earned Value (EV) adalah salah satu teknik untuk menentukan 

keuntungan dan kerugian yang nyata pada proyek-proyek dan menyediakan sarana 

untuk menyeimbangkan keuntungan atau kerugian dan memaksimalkan 

keuntungan (Mahapatni, 2019).  

Metode Earned Value merupakan alat untuk mengontrol kinerja secara 

simultan fisik, biaya, dan jadwal (waktu) secara terpadu, kemajuan biaya dan 

manajemen informasi yang berkaitan dengan lingkup pengadaan, kualitas dan 

resiko secara metode yang luas untuk mengevaluasi, menganalisis, dan 

memprediksi kinerja biaya proyek (Mahapatni, 2019).  

Metode Earned Value (EV) dapat memberikan informasi mengenai posisi 

kemajuan proyek dalam jangka waktu tertentu serta dapat memperkirakan progres 

proyek pada periode selanjutnya, yaitu dalam hal biaya dan juga waktu 

penyelesaian (Husen, 2010).  

Adapun grafik perbandingan antara manajemen biaya tradisional dan 

konsep earned value, dapat dilihat pada Gambar 2.2 berikut: 

 

a. Manajemen Biaya Tradisional b. Konsep Earned Value  

Gambar 2.2 Perbandingan Manajemen Biaya Tradisional dan Konsep Earned 

Value  

Sumber: (Santosa, 2008). 

Seperti yang terlihat pada Gambar 2.2 terdapat grafik yang membandingkan 

anatara manajemen biaya tradisional dengan konsep earned value. Grafik 

manajemen biaya tradisional menyajikan mengenai rencana dan aktual, dimana 

status kinerja tidak dapat diketahui, pada grafik menunjukan biaya aktual lebih 
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rendah, namun pada kenyataannya bahwa biaya aktual yang dikeluarkan lebih 

rendah dari rencana tersebut tidak dapat menunjukan sejauh mana progres kinerja 

yang telah dilakukan apakah sesuai rencana atau tidak. Dapat dilihat pada grafik 

Konsep Earned Value menyajikan mengenai rencana, earned value (nilai hasil), 

dan rencana, dimensi inilah yang merupakan besarnya pekerjaan secara fisik yang 

telah diselesaikan. 

2.6.1 Indikator dan Konsep yang Digunakan 

Berdasarkan konsep nilai hasil (earned value) ada tiga elemen dasar yang 

menjadi acuan dalam menganalisis kinerja suatu proyek, ketiga elemen tersebut 

adalah: 

a. Budgeted Cost for Work Schedule (BCWS)  

BCWS merupakan anggaran biaya yang telah yang direncakan berdasarkan 

jadwal pelaksanaan proyek atau rencana waktu (schedule) yang telah disusun. 

BCWS sebagai acuan kinerja pelaksanaan proyek serta mengidentifikasi 

penyerapan biaya rencana berdasarkan urutan pekerjaan sesuai jadwal yang 

direncanakan (Mahapatni, 2019).  

BCWS dihitung dari akumulasi anggaran biaya yang direncanakan untuk 

pekerjaan dalam periode waktu tertentu. BCWS pada akhir proyek (penyelesaian 

100%) disebut Budget at Completion (BAC), serta menjadi tolak ukur kinerja waktu 

dari pelaksanaan proyek dan merefleksikan penyerapan biaya rencanan secara 

komulatif untuk setiap paket pekerjaan berdasarkan urutannya sesuai jadwal yang 

direncanakan. 

b. Budgeted Cost of Work Performed (BCWP)  

BCWP merupakan anggaran biaya yang telah dikeluarkan berdasarkan 

seluruh aktual pekerjaan yang telah dilaksanakan berdasarkan periode waktu 

tertentu. BCWP tersebut adalah nilai yang dikeluarkan berdasarkan akumulasi 

pekerjaan yang telah selesai dilaksanakan.  

BCWP ini dihitung berdasarkan akumulasi dari pekerjaan yang telah 

diselesaikan. Apabila angka ACWP dibandingkan dengan nilai BCWP, maka akan 

terlihat perbandingan antara biaya yang telah dikeluarkan untuk pekerjaan yang 

telah terlaksana terhadap biaya yang seharusnya dikeluarkan untuk maksud 

tersebut. 
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c. Actual Cost for Work Performed (ACWP)  

ACWP merupakan biaya aktual yang telah dikeluarkan untuk 

menyelesaikan pekerjaan berdasarkan periode waktu tertentu. Anggaran biaya 

aktual dihitung berdasarkan biaya langsung dan biaya tidak langsung (Overhead). 

Yang termasuk tanggungan dari biaya langsung adalah biaya bahan/material dan 

biaya peralatan. Biaya tidak langsung proyek adalah 10% dari biaya tenaga kerja 

(Mahapatni, 2019). 

Dengan menggunakan tiga indikator di atas, dapat dihitung berbagai faktor 

yang menunjukan kemajuan dan kinerja pelaksanaan proyek, untuk metode earned 

value menggunakan tiga jenis kurva sebagai nilai kumulatif biaya dengan fungsi 

waktu, yang terintegrasi dalam satu tampilan yang terdiri atas nilai kumulatif biaya 

yaitu BCWS, BCWP dan ACWP. Dari ketiga hal tersebut dilakukan analisis 

terhadap penyimpangan yang terjadi pada biaya dan waktu atau jadwal dengan cara 

mengukurnya, diuraikan dibawah ini (Husen, 2010): 

1. Penyimpangan Jadwal/Waktu 

a. SV (Scheduling Variance) = BCWP – BCWS 

SV > 0, progres aktual > rencana: terjadi percepatan proyek terhadap 

rencana (schedule underrun). 

SV < 0, progres aktual < rencana: terjadi keterlambatan proyek terhadap 

rencana (schedule overrun). 

b. SPI (Schedule Performance Index) = BCWP/BCWS 

SPI > 1, progres aktual > rencana: terjadi percepatan proyek terhadap 

rencana (schedule underrun). 

SPI < 1, progres aktual < rencana: terjadi keterlambatan proyek terhadap 

rencana (schedule overrun). 

2. Penyimpangan Biaya 

a. CV (Cost Variance) = BCWP – ACWP 

CV > 0, biaya volume aktual > biaya aktual (Cost underrun).  

CV < 0, biaya volume aktual < biaya aktual (Cost overrun). 

b. CPI (Cost Performance Index) = BCWP/ACWP 

CPI > 0, biaya volume aktual > biaya aktual (Cost underrun). 

 CPI < 0, biaya volume aktual < biaya aktual (Cost overrun). 
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Dengan menghitung indeks seperti diatas akan terlihat bahwa proyek akan 

terlambat atau lebih cepat dan biaya yang harus dikeluarkan akan berlebih 

ataukurang dari yang dianggarkan, maka kemajuan proyek untuk waktu yang 

akan datang perlu diramalkan dengan cara seperti dibawah ini (Husen, 2011): 

1. Perkiraan penyelesaian proyek (Estimated Completion Date) 

 ECD = (Sisa waktu/ SPI) + waktu terpakai 

Presentase keterlambatan / percepatan 

= 100% - ECD / Jadwal Rencana x 100% 

2. Pekiraan Biaya penyelesaian proyek (Estimated at Completion)  

EAC = (Sisa Anggaran/ CPI) + ACWP 

= (Total Biaya – BCWP) / CPI + ACWP 

Presentase biaya penambahan atau penurunan biaya aktual terhadap 

anggaran biaya = 100% - EAC/Total Biaya x 100% 

3. Earned Value (Nilai Hasil) = BCWP (Biaya penyelesaian volume 

pekerjaan pada periode tertentu) 

Ketiga hal diatas adalah indikator yang dapat dihitung pada 

baseline/milestone yang telah ditentukan, sehingga nilai-nilai yang didapat 

menunjukkan progres proyek yang ada pada periode tersebut dan progres proyek 

dari segi biaya dan waktu untuk penyelesaian pada masa yang akan datang. (Husen, 

2010) 

2.6.2 Analisis Kinerja Proyek 

a. Varians Biaya dan Jadwal Terpadu 

Telah disebutkan sebelumnya bahwa menganalisis kemajuan proyek 

dengan memakai metode varians sederhana dianggap kurang mencukupi, karena 

analisis varians tidak mengintegrasikan aspek biaya dengan jadwal. Untuk 

mengatasinya digunakan metode nilai hasil dengan indikator BCWS, ACWP dan 

BCWP. Varians yang dihasilkan disebut varians biaya terpadu (CV) dan varians 

jadwal terpadu (SV). (Soeharto, 1997) 

a. Varians Biaya (CV) = EV-AC atau CV = BCWP-ACWP 

- Negative (-) = Cost Overrun (biaya di atas rencana) 

- Nol (0)  = Sesuai biaya  

- Positive (+) = Cost Underrun (biaya di bawah rencana) 
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b. Varians Jadwal (SV) = EV-PV atau SV = BCWP-BCWS 

- Negative (-) = terlambat dari jadwal 

- Nol (0) = tepat waktu 

- Positive (+) = lebih cepat dari jadwal 

Menurut (Ervianto, 2004 dalam Priyo, M., & Wibowo, N. A. 2008) terdapat 

analisis varians terpadu antara Cost Variance dan Schedule Variance (SV), dapat 

dilihat pada Tabel 2.1 berikut: 

Tabel 2.1 Analisis Varians Terpadu 

Varian Jadwal 

(SV) 

Varian Biaya 

(CV) 

Keterangan 

Positif Positif Pekerjaan terlaksana lebih cepat 

dibandingkan pekerjaan pada jadwal 

rencana, serta biaya lebih kecil (hemat) 

dibandingkan anggaran rencana.  

Nol Positif Pekrjaan terlaksana tepat sesuai jadwal 

rencana, serta biaya lebih kecil (hemat) 

dibandingkan anggaran rencana. 

Positif Nol Pekerjaan terlaksana lebih cepat 

dibandingkan pekerjaan pada jadwal 

rencana, serta biaya yang dikeluarkan 

sesuai dengan anggaran. 

Nol Nol Pekerjaan terlaksana tepat sesuai 

jadwal rencana, serta anggaran yang 

dikeluarkan tepat sesuai rencana. 

Negatif Negatif Pekerjaan selesai terlambat, serta biaya 

yang dikeluarkan lebih tinggi dari 

anggaran (boros). 

Nol Negatif Pekerjaan terlaksana tepat sesuai 

dengan jadwal rencana, serta biaya 

yang dikeluarkan lebih tinggi dari 

anggaran (boros). 
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Negatif Nol Pekerjaan selesai terlambat, serta biaya 

yang dikeluarkan sesuai dengan 

rencana anggaran 

(Sumber: Ervianto, 2004 dalam Priyo, M., & Wibowo, N. A. 2008). 

b. Indeks Produktivitas dan Kinerja 

Pengelola proyek seringkali ingin mengetahui penggunaan sumber daya, 

yang dapat dinyatakan ssebagai indeks produktivitas atau indeks kinerja. Indeks 

kinerja ini terdiri dari indeks kinerja biaya Cost Performance Index (CPI) dan 

indeks kinerja jadwal Schedule Performance Index (SPI). 

Cost Performance Index (CPI) = EV/AC atau CPI = BCWP/ACWP 

Schedule Performance Index (SPI) = EV/PV atau SPI = BCWP/BCWS 

Maka dengan kriteria indeks kinerja (performance indeks): 

i. Indeks kinerja < 1, berarti pengeluaran lebih besar daripada anggaran atau 

waktu pelaksanaan lebih lama dari jadwal yang direncanakan. Bila anggaran 

dan jadwal sudah dibuat secara realistis, maka berarti ada sesuatu yang tidak 

benar dalam pelaksanaan kegiatan. 

ii. Indeks kinerja > 1, maka kinerja penyelenggaraan proyek lebih baik dari 

perencanaan, lebih kecil dari anggaran atau jadwal lebih cepat dari rencana. 

iii. Indeks kinerja makin besar perbedaannya dari angka 1, maka makin besar 

penyimpangannya dari perencanaan dasar atau anggaran. Bahkan bila 

didapat angka yang terlalu tinggi berarti prestasi pelaksanaan pekerjaan 

sangat baik, perlu pengkajian lebih dalam apakah mungkin dalam arti 

pengeluaran perencanaannya atau anggaran yang justru tidak realistis. 

c. Proyeksi Pengeluaran Biaya dan Jangka Waktu Penyelesaian Proyek 

Membuat prakiraan biaya atau jadwal penyelesaian proyek berdasarkan atas 

indikator yang diperoleh saat pelaporan akan memberikan petunjuk besarnya biaya 

pada akhir proyek (estimasi at completion = EAC) dan prakiraan waktu 

penyelesaian proyek (estimate all schedule = EAS). Prakiraan biaya atau jadwal 

bermanfaat karena memberikan peringatan dini mengenai hal-hal yang akan terjadi 

pada masa yang akan datang, bila kecenderungan yang ada pada saat pelaporan 

tidak mengalami perubahan. Bila pada pekerjaan tersisa dianggap kinerjanya 
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tetap seperti pada saat pelaporan, maka prakiraan biaya untuk pekerjaan 

tersisa (ETC) adalah: 

ETC = (BAC-BCWP)/CPI  

EAC = ACWP + ETC  

Sedangkan prakiraan waktu penyelesaian seluruh pekerjaan: 

ETS = (sisa waktu)/SPI 

EAS=Waktu selesai+ETS 

Dimana beberapa istilah diantaranya yang didefinisikan dengan:  

a. Budgeted At Completion (BAC) merupakan anggaran biaya proyek 

keseluruhan setelah dikurangi Pajak Pertambahan Nilai (PPN). 

b. Schedule Performance Indeks (SPI) merupakan indeks kinerja jadwal atau 

perbandingan antara penyelesaian pekerjaan di lapangan dengan pekerjaan 

yang direncanakan. 

c. Cost Performance Indeks (CPI) merupakan indeks kinerja biaya atau 

perbandingan antara nilai yang diterima dari penyelesaian pekerjaan 

d. ETC (Estimate Temporary Cost) = Prakiraan Biaya Untuk Pekerjaan 

Tersisa  

e. EAC (Estimate Temporary Cost) = Prakiraan Total Biaya Proyek 

f. ETS (Estimate Temporary Schedule) = Prakiraan Waktu Untuk Pekerjaan 

Yang Tersisa 

g. EAS (Estimate All Schedule) = Prakiraan Total Waktu Proyek 

2.7 Oracle Primavera Project Planner P6 

Primavera System Inc. merupakan perusahaan yang bergerak di bidang 

program (software) manajemen konstruksi. Perusahaan dengan program ruang 

lingkup yang lengkap dan terintegritas untuk perencanaan (planning), pengaturan 

(organizing), pengawasan (controling) dan koordinasi (coordinating). (Kareth, 

dkk. 2012 dalam Maulidy, dkk. 2020) 

Salah satu keutamaan merencanakan penjadwalan dengan menggunakan 

alat bantu komputer berikut software penunjang adalah kemampuan mengolah data 

dalam jumlah besar serta dapat meminimalisir kesalahan, maka penyusunan jadwal 

dapat dilakukan dengan lebih cepat dan teliti.  
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Perangkat lunak Oracle Primavera Project Planner P6 merupakan sebuah 

aplikasi pengelola proyek konstruksi dengan ruang lingkup yang lengkap, terukur 

serta terintegrasi dalam merencanakan, pengorganisasian, serta pengawasan 

proyek. Aplikasi program Primavera dapat digunakan pada manajemen 

pengendalian proyek seperti merencanakan schedule, biaya, sumber daya dan 

tenaga kerja pada proyek berskala kecil, sedang maupun besar. 

Menurut (Kareth, dkk. 2012 dalam Maulidy, dkk. 2020) adapun 

keunggulan, tahapan pengerjaan serta output yang diperoleh dari program ini 

diantaranya: 

a. Dapat mengatur informasi proyek dengan menggunakan kode-kode 

aktivitas, sumber daya serta tanggal sebagai kerangka struktural. 

b. Dapat digunakan pada proyek dengan 1-100.000 kegiatan per proyek. 

c. Dapat mengontrol dan membuat jadwal pekerjaan yang kompleks. 

d. Dapat mengendalikan kegiatan pada setiap sumber daya dan durasi pada 

setiap sumber daya. 

e. Dapat menghitung biaya per jenis pekerjaan dan biaya total proyek. 

f. Dapat mengendalikan biaya dan jadwal proyek. 

Sedangkan tahapan perencanaan pada sebuah proyek konstruksi yang dapat 

dibuat menggunakan program Primavera P6, diantaranya: 

a. Membuat jadwal baru. 

b. Input kalender kerja proyek 

c. Memasukan data kegiatan. 

d. Input durasi kegiatan. 

e. Mengatur hubungan ketergantungan antar aktivitas. 

f. Melakukan schedule pekerjaan. 

g. Input daftar harga satuan bahan dan upah. 

h. Alokasi sumber daya pada setiap pekerjaan. 

i. Pengaturan kegiatan. 

Data-data yang telah diperoleh, kemudian diolah, sehingga menghasilkan 

output diantaranya: 

a. Lay Out Gantt Chart (Diagram batang) 

b. Budgeted Cost (Anggaran biaya proyek) 
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c. Resource Profile (Profil sumber daya) 

d. Resource Table (Tabel sumber daya) 

Sebagai pendukung kebutuhan organisasi dalam melakukan proses 

manajemen waktu dan biaya, mengelola sumber daya, mengelola sejumlah proyek 

besar maka perangkat lunak Primavera dirancang untuk memenuhi kebutuhan 

tersebut. Perangkat lunak ini terintegrasi menggunakan manajemen proyek PPM 

(Portofolio Project Management) sebagai pendukung kebutuhan manajemen 

proyek di lokasi yang berbeda dan pada berbagai tingkat perusahaan. 

Dalam menggunakan manajemen proyek PPM (Portofolio Project 

Management) sebagai pendukung kebutuhan manajemen proyek, maka 

memungkinkan sebuah organisasi untuk: 

a. Membuat strategi pelaksanaan 

b. Mengdendalikan detail yang dibutuhkan untuk menyelesaikan proyek 

c. Memahami kebutuhan sumber daya, menetapkan prioritas serta 

mengevaluasi kebutuhan staf jangka panjang. 

d. Menggunakan kemampuan sumber daya secara baik dan merata. 

e. Mengendalikan proyek dengan tujuan agar proyek sesuai dengan pergeseran 

prioritas tanpa mengesampingkan kualitas. 

Dengan beberapa keunggulan tersebut, maka pengelolaan proyek konstruksi 

dengan menggunakan Primavera P6, khususnya untuk para manajer proyek dapat 

membantu dalam Work Breakdown Structure (WBS), mengumpulkan data proyek 

untuk selanjutnya dilakukan penginputan resource yang dibutuhkan seperti labour, 

material, equipment, subcont, volume, dan harga satuan, dapat memonitoring 

aktivitas pekerjaan, menampilkan informasi aktual mengenai aktivitas proyek 

melalui tampilan S-Curve, melakukan pengendalian hasil pekerjaan berikut laporan 

pengendalian tersebut. 

Beberapa istilah khusus mengenai struktur pada program Primavera P6, 

diantaranya: 

1. Task adalah salah satu bentuk lembar kerja dalam software Primavera yang 

berisi mengenai rincian pekerjaan sebuah proyek, serta perintah yang 

dilakukan untuk proses pengelompokan pekerjaan. 
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2. Duration adalah jangka waktu yang dibutuhkan untuk menyelesaikan 

pekerjaan. 

3. Start adalah nilai tanggal dimulainya suatu pekerjaan. 

4. Finish adalah tanggal berakhirnya suatu pekerjaan. 

5. Predecessor merupakan hubungan keterkaitan antara satu pekerjaan dengan 

pekerjaan lain. 

6. Resources adalah sumber daya manusia ataupun material. 

7. Cost adalah biaya yang digunakan baik untuk gaji maupun material yang 

digunakan. 

8. Pert Chart adalah diagram yang lebih fokus pada hubungan antar 

pekerjaan, yang digambarkan dalam bentuk network diagram. 

9. Baseline adalah suatu rencana baik jadwal maupun biaya yang telah 

disetujui dan ditetapkan, digunakan sebagai acuan perbandingan antara 

rencana dan aktual dilapangan. 

10. Hasil Gant Chart adalah salah satu bentuk tampilan dari hasil kerja 

Primavera yang berupa batang horizontal yang menggambarkan masing-

masing pekerjaan beserta durasinya. 

11. Tracking adalah peninjauan hasil kerja dilapangan dengan rencana semula 

dalam Primavera. 

12. Milestone adalah penanda yang diletakan pada suatu posisi pekerjaan agar 

mudah diketahui. Milestone tidak mewakili suatu kegiatan melainkan 

digunakan sebagai petunjuk atas suatu perkembangan proyek.  

Adapun struktur program Primavera P6 yang dilakukan untuk menyusun 

rencana jadwal (schedule), adalah sebagai berikut: 

1. Membuka Lembar Kerja Baru 

Klik tombol Start > Program > Primavera P6 

2. Membuat File Proyek Baru 

Klik menu File > New > Select EPS > Next > tentukan kode identitas 

proyek pada Project ID > tentukan nama proyek pada Project Name > 

Next > tentukan tanggal dimulainya proyek pada Planned Start > tentukan 

tanggal berakhirnya proyek pada Must Finish By > Next > tentukan kepala 

proyek pada Responsible Manager > Next > tentukan satuan yang 
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digunakan pada Rate Type > Next > tentukan apakah akan menggunakan 

Project architect atau tidak pada Project Architect > Next > Finish. 

 

Gambar 2.3 Membuat File Project Baru 

3. Buka Project yang telah dibuat > buat Work Breakdown Structure (WBS) 

> Klik perintah menu WBS > isi dengan urutan pekerjaan.  

 

Gambar 2.4 Menyusun Work Breakdown Structure (WBS) 

4. Membuat aktivitas hubungan pekerjaan > Klik menu Activities > isi detail 

aktivitas (list pekerjaan) > Klik tombol (+) untuk menambahkan aktivitas > 

Menentukan durasi pekerjaan berdasarkan volume pekerjaan pada kolom 

Original Duration 
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Gambar 2.5 Menyusun Aktivitas 

5. Membuat hubungan antara pekerjaan satu dengan yang lainnya pada tab 

Relationship Finish to Start (FS), Start to Finish (SF), Finish to Finish 

(FF), Start to Start (SS) > Hubungan antar pekerjaan berdasarkan gambar 

kerja (shop drawing) > klik pada aktivitas > menentukan predecessor 

 

Gambar 2.6 Membuat Hubungan Antar Pekerjaan 

6. Menyusun kalender kerja untuk menentukan hari kerja dan jam kerja. Klik 

menu Tools > Schedule > Option > Schedule Automatically when a 

Change effects dates > Close > Schedule. 
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Gambar 2.7 Menyusun Kalender Kerja 

7. Menyimpan rencana jadwal dan biaya sebagai baseline. Klik menu Project 

> Maintain Baseline > Add > Close kemudian klik Project > Assign 

Baseline, pada kotak dialog Project Baseline dan Primary diganti  

Baseline yang telah ditambahkan tadi kemudian klik OK > Close. Akan 

terlihat tambahan warna pada Gant Chart. 

 

Gambar 2.8 Menyimpan Rencana Jadwal (Baseline)  

2.8 Microsoft Project Profesional 

Microsoft Project merupakan sebuah perangkat lunak yang dapat digunakan 

sebagai aplikasi pengelola proyek konstruksi dan digunakan untuk mengelola 

rencana pekerjaan dan waktu pekerjaan, sehingga sebuah proyek yang sedang 

berjalan dapat dipantau serta dievaluasi sesuai dengan tahapan pengerjaannya.  
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Perangkat lunak Microsoft Project dapat memberikan unsur manajemen 

proyek yang sempurna dengan memadukan kemudahan penggunaan, kemampuan, 

dan fleksibilitas sehingga menjadi lebih produktif dengan mengintegrasikan 

program-program seperti Microsoft Office dalam membuat laporan, 

mengendalikan perencanaan dan sebagai sarana fleksibel (Alfred, 2019). 

Dalam tahapan progres input data, Microsoft Project dapat memperlihatkan 

hasil perhitungan secara langsung. Data perencanaan proyek tidak akan selesai 

sebelum seluruh informasi kritis mengenai kegiatan tersebut dimasukkan, 

selanjutnya maka waktu selesai proyek akan terlihat. Aplikasi Microsoft Project 

menyimpan data yang telah di input, maka akan diketahui informasi seperti 

deskripsi kegiatanserta jalur kritis proyek. Setiap data di input melalui field dan 

kemudian muncul melalui sebuah kolom. 

Diantara berbagai aplikasi program yang ada sekarang ini yaitu Microsoft 

Project dan Primavera yang digunakan dalam pekerjaan planning, controling, 

scheduling, dan estimating. Dalam penentuan penggunaan aplikasi untuk 

menganalisis waktu dan biaya proyek. Keduanya merupakan aplikasi yang dapat 

digunakan pada proyek sebagai pengendalian waktu dan biaya, dengan tujuan 

optimalisasi. Adapun perbandingan diantara keduanya, yaitu: 

1. Menurut (Octavia, dkk. 2013) hasil penelitian menunjukan keduanya 

memiliki kemampuan yang relatif sama. Pada Microsoft Project sangat user 

friendly, tidak memerlukan waktu yang lama dalam menyelesaikan 

hubungan antar aktivitas, sangat kompatible dengan Microsoft Excel, 

memiliki kemampuan membuat jadwal kerja atau sistem kalendering 

dengan berbagai macam constraints, dan sangat baik digunakan pada proyek 

skala kecil. Sedangkan, Primavera baik dalam menampilkan grafik 

resource, cost, dan kurva S, serta mengatur informasi proyek dengan 

menggunakan kode aktivitas dan sangat baik digunakan pada proyek skala 

menengah sampai besar.  

2. Menurut penelitian (Alfred, 2019) yang membandingkan program 

Microsoft Project dan Primavera, menyimpulkan bahwa:  

a. Keduanya memiliki kemampuan serta hasil yang relatif sama terhadap 

perencanaan penjadwalan. Namun disisi lain Oracle Primavera P6 
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mampu mengevaluasi sebuah risiko bagi kebutuhan manajemen, yang 

bertujuan untuk mengidentifikasi masalah yang akan terjadi pada 

perencanaan yang dikarenakan oleh suatu risiko, lalu 

mendeterminasikan dampak pada pekerjaan proyek berdasarkan 

probabilitas, biaya dan jadwal, serta pengambilan keputusan terhadap 

risiko yang akan terjadi.  

b. Microsoft Project memiliki interface yang mudah digunakan untuk 

mengatur tampilan serta waktu pada aktivitas proyek, memiliki 

representasi visual yang mudah untuk dimengerti serta memiliki 

integrasi dengan Microsoft Office lainnya. Sedangkan Primavera lebih 

unggul perencanaan sumber daya dan pengendalian biaya, mempunyai 

kapasitas pendukung banyak hubungan aktivitas dimana lebih dari satu 

jenis hubungan dapat dibuat antar kegiatan. Aplikasi Primavera 

dilengkapi dengan sistem keamanan untuk meminimalisir hal-hal yang 

tidak diinginkan pada pekerjaan proyek yang bersifat sensitif.  

2.9 Tahapan Perencanaan dan Penjadwakan Proyek dalam Program  

Proyek pada dasarnya adalah urutan seperangkat aktivitas yang harus 

diselesaikan dalam kurun waktu tertentu untuk mencapai hasil atau tujuan. 

Penjadwalan proyek merupakan langkah untuk merumuskan aktivitas 

berdasarkan jangka waktu dan hubungan antar aktivitas tersebut. Setiap kegiatan 

membutuhkan waktu untuk mencapai target proyek dan dapat menggunakan 

sumber daya yang memiliki ketersediaan terbatas seperti tenaga kerja, material, alat 

dan biaya.  

Aplikasi program perencanaan dan penjadwalan proyek seperti umumnya 

Microsoft Project dan Primavera P6, dapat memungkinkan estimator untuk: 

a. Memasukkan Work Breakdown Structure (WBS) dari data proyek dan 

semua struktur proyek yang dibutuhkan ke dalam aplikasi program. 

b. Menyederhanakan proyek ke dalam aktivitas-aktivitas yang dibutuhkan 

untuk dimasukkan dalam aplikasi program. Aktivitas tersebut disesuaikan 

dengan WBS.  
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c. Menetapkan kalender, jangka waktu, constraints, predecessors dan 

successor setiap aktivitas dan kemudian menghitung tanggal mulai dan 

akhir dari aktivitas tersebut.  

d. Menetapkan sumber daya dan biaya seperti pekerja, peralatan atau bahan 

dari setiap aktivitas yang kemudian disesuaikan dan dihitung menurut 

kebutuhan sumber daya proyek.  

e. Mengoptimalkan rencana kerja proyek.  

f. Menetapkan tanggal dasar dan anggaran biaya dasar untuk dapat 

dibandingkan sesuai kemajuannya dalam proyek.  

g. Menyepakati tanggal dimulainya pekerjaan proyek.  

h. Mengamati kemajuan aktual dari setiap aktivitas terhadap rencana awal dan 

memperbaiki rencana yang ada jika diperlukan,  

i. Mengamati penggunaan sumber daya dan biaya sehingga dapat 

memperkirakan sumber daya dan biaya yang dibutuhkan untuk 

menyelesaikan proyek itu.  

j. Membuat laporan kemajuan manajemen proyek.  

Selanjutnya, setiap aplikasi program yang digunakan untuk penjadwalan 

proyek setidaknya telah dibuat untuk memiliki kemampuan standar yang terbagi 

menjadi beberapa tahapan sehingga dapat digunakan dengan efektif. Ada 4 

tahapan/level dalam perencanaan dan penjadwalan suatu software (Harris, 2008, 

page 4) dapat dilihat pada Tabel 2.2. 

Dengan meningkatnya level, jumlah informasi yang diperlukan untuk 

penjadwalan proyek ini akan meningkat. Selain itu, keterampilan dan pengetahuan 

dalam menggunakan aplikasi program juga akan meningkat sesuai level yang ada. 

Tabel 2.2 Tahapan Perencanaan dan Penjadwalan Proyek  

 PLANNING TRACKING 

WITHOUT 

RESOURCES 

LEVEL 1:  

Planning without resources 

LEVEL 2: 

Monitoring without resources 

WOTH 

RESOURCES 

LEVEL 3: 

Scheduling with resources, 

roles, and budget 

LEVEL 4: 

Monitoring progress of a 

resourced schedule 

Sumber: (Harris, 2010) 
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2.9.1 Level 1 – Perencanaan Tanpa Sumber Daya 

Ini adalah level paling sederhana dalam perencanaan proyek pada aplikasi 

program, meliputi:  

a. Memulai proyek.  

b. Mendefinisikan calendar.  

c. Mendefinisikan sistem struktur pengkodean proyek.  

d. Menambahkan sub-aktivitas untuk mewakili sebuah aktivitas.  

e. Mendefinisikan aktivitas dan menggunakan milestone.  

f. Menambahkan hubungan yang logis antar aktivitas.  

g. Menentukan constraints.  

h. Menganalisis resiko. 

i. Penjadwalan proyek dengan critical path.  

j. Menyiapkan tolerance.  

k. Mengatur tampilan – views, tables, dan filter.  

l. Printing and Reports.  

m. Mengkomunikasikan rencana proyek.  

2.9.2 Level 2 – Meminitor Perkembangan Tanpa Sumber Daya 

Pada level ini, ada beberapa perkembangan dari level sebelumnya, yaitu: 

a. Mengatur baseline 

b. Melakukan tracking progress. 

2.9.3 Level 3 – Perencanaan Dengan Sumber Daya 

Level ini untuk merencanakan suatu proyek dengan memasukkan sumber 

daya yang ada sehingga dapat:  

a. Estimasi dan Perencanaan Pengendalian Biaya  

b. Keseimbangan antara jumlah kegiatan dan sumber daya.  

c. Menciptakan dan menggunakan sumber daya  

d. Kalender sumber daya, jenis kegiatan, dan mengendalikan sumber daya  

e. Penggunaan task types  

f. Penggunaan Grafik dan Tabel sumber daya  

g. Adanya Resource Leveling  
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2.9.4 Level 4 – Memantau Kemajuan Jadwal Sumber Daya 

Level ini dipakai jika ingin memperbaharui sumber daya proyek tetapi 

dengan mengumpulkan informasi tambahan terlebih dulu seperti:  

a. Kuantitas atau jam atau biaya yang dikeluarkan sampai saat ini per kegiatan 

untuk setiap sumber daya.  

b. Kuantitas atau jam atau biaya yang dibutuhkan per sumber daya untuk 

menyelesaikan setiap kegiatan.  

Data-data tersebut akan dapat menjelaskan status penjadwalan dari setiap 

sumber daya. Status sumber daya tersebut harus direview dari kebutuhan sumber 

daya masa depan, kemajuan proyek, tanggal akhir proyek, arus kas, dan kinerja 

sebelumnya. Menjadwalkan status sumber daya membutuhkan pemahaman yang 

baik tentang bagaimana aplikasi program tersebut menghitungnya. 

2.10 Metode Percepatan Pelaksanaan Pekerjaan (Crash Program) 

Pada umumnya istilah proses crashing merupakan mereduksi atau 

mengubah metode suatu pekerjaan yang berpengaruh terhadap kegiatan waktu 

(durasi) penyelesaian proyek. Proses crashing adalah cara melakukan perkiraan 

dari variable cost dalam menentukan pengurangan durasi yang paling maksimal 

dan paling ekonomis dari suatu kegiatan yang masih mungkin untuk direduksi 

(Ervianto, 2004).  

Crashing merupakan cara mempersingkat waktu dari aktivitas pekerjaan 

dengan menambah sumber daya dan biaya langsung, Pada saat melakukan metode 

crashing maka nama kegiatan serta besaran biaya aktivitas harus ditetapkan. 

Dalam melakukan proses percepatan waktu (crashing) maka setiap 

pekerjaan membutuhkan infomasi berikut, diantaranya: 

1. Perkiraan biaya yang dibutuhkan setiap item pekerjaan dalam situasi 

normal. 

2. Penyelesaian waktu proyek pada saat kondisi percepatan, merupakan waktu 

paling singkat yang dapat dilakukan di bawah kondisi percepatan. 

3. Perkiraan biaya tenaga kerja dalam kondisi percepatan. 

Pelaksanaan konstruksi yang dipersingkat akan menghasilkan biaya yang 

lebih besar dari perencanaan serta kualitas yang cenderung lebih rendah. Pada 

umumnya, tidak diharapkan adanya hubungan linear antara durasi dan biaya 
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langsung, tetapi fungsi parabola (convex function) seperti kurva nonlinear atau 

fungsi bertingkat (step function) (Hendrickson, 1998). Contohnya crashing dengan 

adanya lembur maka upah pekerja akan bertambah sedangkan angka produktivitas 

tenaga kerja akan berkurang.  

Menurut Frederika dalam Violita (2020), terdapat 4 faktor yang dapat 

dioptimalkan untuk melaksanakan percepatan pada suatu proyek, diantaranya: 

1. Penambahan jumlah tenaga kerja 

2. Penjadwalan kerja lembur 

3. Penambahan atau penggantian peralatan yang lebih produktif 

4. Mengubah metode konstruksi di lapangan 

2.10.1 Produktivitas Tenaga Kerja 

John Soeptihanto berpendapat bahwa produktivitas adalah perbandingan 

antara hasil yang dicapai dengan keseluruhan sumber daya yang dipengaruhi atau 

perbandingan jumlah produksi (output) dengan sumber daya yang digunakan 

(input), Setiawan dalam Violita (2020). 

Produktivitas tenaga kerja = 
1 

Koefisien tenaga kerja 

Terdapat persamaan yang menyatakan produktivitas tenaga kerja menurut 

Cornelia dalam Violita (2020), yaitu: 

Produktivitas tenaga kerja = 
Volume 

Durasi × Jumlah tenaga kerja  

Menurut Kaming dalam Violita (2020), terdapat 3 faktor yang 

mempengaruhi produktivitas, diantaranya: 

1. Metode dan teknologi yang digunakan yaitu meliputi desain rekayasa, 

metode konstruksi, urutan kerja dan pengukuran kerja. 

2. Manajemen lapangan, meliputi perencanaan dan penjadwalan, tata letak 

lapangan, komunikasi lapangan, manajemen material, manajemen 

peralatan, manajemen tenaga kerja. 

3. Faktor manusia, meliputi tingkat upah kerja, kepuasan kerja, insentif, 

pembagian keuntungan, hubungan kerja mandor-pekerja, hubungan kerja 

antar sejawat dan kemangkiran (tindakan tidak masuk kerja tanpa alasan). 
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Penurunan indeks produktivitas tenaga kerja tiap jam akibat lembur 

ditunjukan pada Gambar 2.9 berikut. 

 

Gambar 2.9 Grafik Indikasi Turunnya Produktivitas Akibat Kerja Lembur 

(Sumber: Soeharto, 1997) 

2.10.2 Penambahan Kerja Lembur 

Adapun rencana kerja yang akan dilakukan dalam mempercepat durasi 

sebuah pekerjaan dengan metode jam kerja lembur, diantaranya adalah: 

1. Waktu kerja normal adalah 8 jam (08.00 – 17.00), sedangkan lembur 

dilakukan setelah waktu kerja normal. 

2. Harga upah pekerja untuk kerja lembur menurut Keputusan Menteri Tenaga 

Kerja Nomor KEP.102/MEN/VI/2004 pasal 11 diperhitungkan sebagai 

berikut: 

a. Perhitungan upah lembur berdasarkan pada upah bulanan 

b. Cara menghitung upah kerja lembur, diantaranya dengan rumus: 

1) Upah jam lembur pertama = 1,5 × upah sejam 

2) Upah jam lembur kedua dan seterusnya = 2 × upah sejam 

c. Produktivitas untuk 4 jam kerja lembur diperhitungkan sebesar 60% dari 

produktivitas normal (Soeharto, 1999) 

Ada beberapa hal yang harus diperhatikan dalam melaksanakan kerja 

lembur, diantaranya: 

1. Bersedianya pekerja untuk melakukan lembur. 

2. Penurunan produktivitas kerja para pekerja. 

3. Upah harus dibayar lebih tinggi dari upah yang biasa dibayarkan. 
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4. Tidak perlu tambahan tenaga kerja. 

5. Perlu adanya penambahan penerangan karena biasanya lembur diadakan 

sampai malam hari 

2.10.3 Penambahan Tenaga Kerja 

Terdapat beberapa hal yang harus diperhatikan dalam melaksanakan 

penambahan tenaga kerja, yaitu: 

1. Bersedianya pekerja untuk menjadi pekerja tidak tetap. 

2. Produktivitas tenaga kerja akan terjaga 

3. Kerjasama dalam tim akan berkurang 

Adapun ilustrasi grafik hubungan waktu-biaya normal serta waktu-biaya 

pada saat proyek dilakukan percepatan (crashing), dapat dilihat pada Gambar 2.10 

berikut ini. 

 

Gambar 2.10 Grafik Hubungan Waktu-Biaya Normal dan Dipersingkat 

(Sumber: Soeharto, 1997) 

Pada Gambar 2.10 diperlihatkan hubungan antara biaya dan waktu. Apabila 

waktu dipersingkat, maka biaya yang dibutuhkan juga akan meningkat dari biaya 

normal. Hal ini terjadi karena peningkatan pengeluaran biaya langsung, seperti gaji 

pekerja peralatan dan sebagainya. 

2.10.4 Sistem Shift Kerja 

Koefisien produktivitas tenaga kerja pada system shift dalam persen telah 

diketahui sebesar 11% - 17% dan biaya langsung kerja shift biasanya dikenakan 

biaya tambahan sebesar 15% untuk upah pekerja dari upah pekerja normal (Hanna, 

2008) dalam Juniza, 2020. 
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Adapun perhitungan tahapan percepatan durasi penyelesaian proyek dengan 

system shift, sebagai berikut: 

1. Menghitung Produktivitas 

𝑃𝑟𝑜𝑑𝑢𝑘𝑡𝑖𝑣𝑖𝑡𝑎𝑠 =
𝑉𝑜𝑙𝑢𝑚𝑒

𝐷𝑢𝑟𝑎𝑠𝑖 𝑥 𝐽𝑢𝑚𝑙𝑎ℎ 𝑇𝑒𝑛𝑎𝑔𝑎 𝐾𝑒𝑟𝑗𝑎
 

2. Menentukan produktivitas tenaga kerja dengan sistem shift 

Prod. Shift  = Prod.kerja/hari (normal) + (prod.kerja/hari – 

(prod.kerja/hari × 11%) 

3. Menentukan durasi kerja (sistem shift) 

Durasi (shift)   = 
Volume Pekerjaan 

Prod.tenaga kerja shift × jumlah tenaga kerja 

4. Perhitungan Crash Cost pekerjaan dinding ½ bata, camp 1:5. 

Shift Pertama = Jumlah Pekerja × Gaji Pekerja perhari 

2.11 Rencana Mutu Pekerjaan Konstruksi (RMPK) 

Manajemen mutu adalah suatu cara untuk meningkatkan performasi secara 

terus menerus atau berkesinambungan pada setiap tingkat fungsional dari suatu 

organisasi dengan menggunakan sumber daya manusia dan modal yang tersedia. 

Manajemen mutu merupakan kegiatan terkoordinasi untuk mengarahkan dan 

mengendalikan organisasi dalam hal mutu (Peraturan Menteri Pekerjaan Umum 

No. 09 Tahun 2009).  

Menurut Nasution dalam Herlintang (2019), pengertian sistem manajemen 

mutu adalah suatu pendekatan dalam menjalankan usaha yang mencoba untuk 

memaksimalkan daya saing organisasi melalui perbaikan berkesinambungan atas 

produk jasa, tenaga kerja, proses dan lingkungannya.  

Pada umumnya, manajemen mutu merupakan suatu pendekatan yang 

mengarahkan perusahaan untuk melakukan kegiatan pencegahan dan perbaikan 

serta menuju kepada perbaikan terus-menerus terhadap semua proses pekerjaan, 

dan material yang digunakan demi menunjang keberhasilan pekerjaan yang 

dilaksanakan.  

Pembahasan Rencana Mutu Pekerjaan Konstruksi (RMPK) mencakup 

kecukupan terkait persyaratan penyusunan RMPK, serta kesesuaian dengan lingkup 

dan persyaratan dalam kontrak. Dalam maksud dan tujuan nya, RMPK dibuat untuk 
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memastikan suatu pekerjaan proyek pembangunan mencapai target mutu sesuai 

spesifikasi yang sudah ditentukan dalam hal waktu, volume, biaya, maupun 

keselamatan kerja.   

Rencana Mutu Pekerjaan Konstruksi (RMPK) diimplementasikan pada saat 

rapat Persiapan Pelaksanaan Pekerjaan (PCM), dokumen yang telah dibuat oleh 

penyedia jasa dibahas secara detail sesuai dengan komponen yang sudah ditetapkan 

dan sesuai dengan spesifikasi teknis maupun syarat-syarat yang telah disepakati 

bersama saat penandatanganan kontrak.  

Dokumen RMPK diimplementasikan juga pada saat pelaksanaan 

konstruksi. RMPK yang sudah disetujui oleh pengguna jasa secara resmi dapat 

dipakai oleh seluruh stakeholder yang ada pada proyek konstruksi, serta menjadi 

acuan kerja bagi konsultan pengawas proyek konstruksi sebagai Method Statement 

dan rencana pemeriksaan (Inspection and Test Plan/ITP) yang merupakan 

komponen pada RMPK digunakan sebagai salah satu persyaratan dalam 

permohonan izin memulai pekerjaan.  

Pada penyusunannya, ada beberapa komponen yang harus dicantumkan 

dalam dokumen RMPK, diantaranya adalah: 

a. Informasi Pekerjaan 

Memberikan informasi secara garis besar mengenai pekerjaan konstruksi 

yang dilaksanakan. Informasi yaitu berupa data umum pekerjaan, waktu 

pelaksanaan, informasi nama dan alamat pengguna jasa dan pengawas pekerjaan, 

serta lingkup pekerjaan. 

b. Struktur Organisasi 

Struktur organisasi disajikan dalam bentuk bagan alir. Penjelasan tugas dan 

tanggung jawab juga harus dijelaskan dan disajikan dalam bentuk tabel. 

c. Jadwal Pelaksanaan Pekerjaan 

Menuliskan seluruh tahapan rencana kegiatan mulai dari tahap persiapan 

sampai tahap penyelesaian. Jadwal pelaksanaan pekerjaan dalam RMPK 

terintegrasi dengan uraian pekerjaan dalam identifikasi bahaya dan pengendalian 

resiko. 
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d. Gambar dan Spesifikasi Teknis 

Gambar yang dilampirkan adalah gambar layout, potongan, dan yang 

dianggap perlu serta berkaitan dengan pekerjaan di lapangan. Berikan juga uraian 

singkat dan jelas mengenai persyaratan spesifikasi teknis sesuai kontrak. 

e. Tahapan Pekerjaan  

Dibuat dalam bentuk bagan alir, menggambarkan seluruh rangkaian 

pekerjaan yang sistematis dari awal sampai akhir. 

f. Rencana Pemeriksaan dan Pengujian 

Memberikan uraian mengenai daftar, standar prosedur, pedoman 

pelaksanaan dan/atau instruksi kerja yang digunakan untuk setiap pekerjaan, baik 

yang terkait teknis/pelaksanaan pekerjaan maupun terkait penjaminan mutu dan 

pengendalian mutu dan analisis keselamatan konstruksi untuk setiap pekerjaan di 

lapangan. 

g. Rencana Pemeriksaan dan Pengujian 

Menjelaskan prosedur dan rencana inspeksi dan pengujian di lapangan 

untuk memastikan agar mutu produk yang dihasilkan tetap terjaga. 

h. Pengendalian Sub-Penyedia Jasa dan Pemasok 

Menjelaskan rencana penyedia jasa dalam mengendalikan sub-penyedia 

jasa dan pemasok. Pengendalian sub kontraktor/vendor mencakup jumlah dan jenis 

subkon, kriteria pemilihan, prosedur pemilihan, list dan record subkon/vendor.


